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Website: http://www.miniapples.org

Forums: http://miniapples.7.forumer.com

Email: miniapples@mac.com

From the Editor:
Apple released new iMac models that have screens measuring 21.5 inches or 27 inches. That’s a huge
leap from the 13-inch screen on the original “blueberry” iMac that my dad still uses. The new low
end model retails for $1,199 and, from my perspective, appears loaded — 3.06 GHz processor, 4GB
RAM, 500GB hard drive, plus a large built-in LED-backlit screen, and a standard (that’s a first!)
wireless keyboard and mouse. To me, that seems like a lot of computer for the money, and you can
choose to upgrade the machine’s processor, hard drive (2TB), graphics card, and RAM (16GB).
This begs the question: how much computer does one need? My dad’s 350 MHz iMac G3 is due for
replacement, but for what he does — browse the web and send Email — I think I’ll find a previous
generation model that meet his needs — a computer that, for him, will be a step up, but will still be
“good enough.”
Ron Heck, Publications Director
Calendar
At the right is a list of mini’app’les
meetings for November 2009. The
information was compiled as this
newsletter was being assembled and
is subject to change. As always,
confirm the Special Interest Group
(SIG) date, time, and location with the
SIG Leader or the mini’app’les
website: www.miniapples.org.

Meeting
iWork/AppleWorks
SIG
Mac OS X SIG
Mac Q&A SIG
Macintosh
Consultants SIG
VectorWorks SIG*

Meeting Calendar – November 2009
Tuesday
Nov. 3 7:00 pm
Mac OS X SIG
Wednesday Nov. 4 6:30 pm
iWork/AppleWorks SIG
Wednesday Nov. 11 7:00 pm
VectorWorks SIG*
Thursday
Nov. 19 7:00 am Macintosh Consultants SIG
Monday
Nov. 23 7:00 pm
Mac Q&A SIG

Meeting Locations and Leaders
Location
Southdale Library, 7001 York Ave. S., Edina, MN

Leader
John Hunkins Sr, 651-457-8949

The Foundation, 311 7th Ave N, Minneapolis
Merriam Park Library, 1831 Marshall Ave, St Paul

Bob Demeules, 763-559-1124
Les Anderson, 651-735-3953

Good Day Café, 5410 Wayzata Blvd, Golden Valley Bob Demeules, 763-559-1124
CJR Office, 4441 Claremore Dr, Edina

Charles Radloff, 952-941-1667

* This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.
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Notice: BOD Candidates Needed
by Harry Lienke
We need the mini’app’les membership to help
guide our organization in the weeks and
months ahead. The nomination of officers for
the Board of Directors (BOD) for the period
from July 1, 2010, to June 30, 2011, will take
place at the Annual Meeting in February, 2010.
In anticipation of the Annual Meeting, our
President, Bruce Thompson, has appointed a
Nominating Committee consisting of Les
Anderson and himself. They have issued a call
for mini’app’les members interested in making
this group the best Apple User Group possible.
The BOD consists of the Past President and
seven elected officers: President, Vice President,
Treasurer, Secretary, Membership Director,
Publications Director, and SIG Director. Duties
of the officers are detailed in Section E of the
club bylaws (http://homepage.mac.com/
miniapples/Bylaws/Bylaws200805.htm).
The incumbent president (Bruce) and secretary
(yours truly) have announced they are not
interested in serving beyond the end of their
current term. These open positions must be
filled for the club to continue operating. If you
would like to join the BOD in one of these
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positions or in any of the other five elected
positions, please contact the Nominating
Committee or any of the other BOD members
and make your interest known.
Thanks for your help!
Bylaws Update
by Harry Lienke
The mini’app’les Bylaws are the rules the Board
of Directors (BOD) uses to guide them as they
attempt to make our club as useful to its
members as possible. The Bylaws are updated
whenever someone offers a change which is
approved first by the BOD and then by a
majority of members voting in an election. All
members are encouraged to submit ideas for
changes to the BOD either through the
Members Private Forum on forumer.com or by
sending the suggestions to the club mailbox
(miniapples@mac.com).
You may access the latest Bylaws at http://
homepage.mac.com/miniapples/Bylaws/
Bylaws200805.htm. This link enables you to
view the Bylaws on-line.
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Dan Buchler
(1937 - 2009)
by Tom Ostertag
Dan had a marvelous
British accent and a typical
British sense of humor
(probably because he was
born in East Molesey,
England). He graduated
from the University of
Cambridge (1955-1958)
with a Master’s degree in
electrical engineering and
retired from a career with
Honeywell and Alliant
Techsytems.
Dan and twelve others —
one, the owner of
ComputerLand — started
mini’app’les back in 1978.
At the beginning of the club
there were people with Apple ][ computers and
no software to run on them and, for the most
part, no peripherals. Some of the early club
activities were to publish software written by
club members on audio cassettes and build
interfaces to various printers and modems. Dan
was the president of the club for the first two
years of its existence and then continued on for
eight years as the newsletter editor. After that he
backed into the shadows. In 1993, he was listed
on Members Helping Members for Microsoft
Word and Excel, and Mac networking. I guess
he wanted to let the club grow and mature. In
2003 he came back to have a hand in setting up
the 25th anniversary celebration.
When I joined mini’app’les in 1984, Dan was the
editor of the monthly newsletter. It was printed
on a dot matrix printer and was written on
PieWriter, an early word processor program.
The major word processor at the time was
Apple Writer (written by Paul Lutus) and, as I
was learning how to use that program, I would
talk to Dan whenever I needed to do something
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interesting with my Epson FX-80 Dot Matrix
printer. (That printer cost $500 in 1983.)
I also talked with him several times at the
monthly Main Meetings that were held at the
Saint Paul Campus in the Student Activity
Center or one of the large lecture rooms. Some
of the first meetings I attended had over 200
people in attendance. Dan was the coordinator
for a number of those meetings.
Dan worked at Honeywell but not at the same
plant that I did. He was in Information Systems
and was at (I believe) General Offices. I lost
contact with Dan in 1985 when he bought a Fat
Mac and started the Mac Meeting since I
continued to work with the Apple IIe and Apple
IIGS. He started publishing the newsletter on
his Mac and eventually turned the newsletter
over to Dave Undlin. I switched to a Mac in
1993 and by that time the Mac was the major
computer on the Apple scene. Dan had a site on
LinkedIn and is listed as an Independent
Computer Networking Professional.
His memory will live on in Mac computing
circles, and we will miss him.
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mini’app’les Directors
Meeting Minutes for
October 5, 2009
In attendance: Bruce
Thompson, Tim
Drenk, Dave Lundin,
Harry Lienke, Ron
Heck, Les Anderson
Absent: Kevin Strysik,
Tom Gates
Other attendees: Tim Tierney, Erik Knopp
Agenda: Adopted as distributed.
Minutes: The minutes for the August 3, 2009,
Board of Directors (BOD) meeting were
approved electronically and published on
forumer.com on August 10.

Directors’ Reports
Treasurer Dave Lundin’s report: All bills are
paid. A written report was distributed; the
report was reviewed. A motion to approve the
report was made, seconded, and passed (MSP).
The Minnesota Secretary of State requires the
club address to be in Minnesota whereas Dave
lives in Wisconsin. The bylaws need to be
changed to allow state information to be sent to
any BOD member living in Minnesota. Since the
current information registered with the state
specifies only an address and not the name of a
BOD member, the BOD voted to continue as is
until the bylaws are changed.
President Bruce Thompson’s report: Founding
member Dan Buchler died at 72. He was the
first newsletter editor and a former president.
Bruce will contact Tom Ostertag and ask him to
prepare a newsletter article. Our MobileMe
subscription runs out in December; as our
ambassador, Bruce is working on accumulating
points awarded by Apple for accomplishing
various tasks so our subscription will be
renewed at no cost to the club.
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Publications Director Ron Heck’s report: The
size of the newsletter PDF file is getting
excessively large. Bruce reduced the file size
using Acrobat. Ron discovered Pages has
settings for exporting PDFs with good, better,
and best image quality; going from best quality
to good quality reduced the newsletter file size
from 4 megs to .5 meg. Someone pointed out
that Pages also has a Reduce File Size command
on the File menu that may be of some help in
reducing file size. Ron has received email
requests about our policy on ads in the
newsletter; although we had ads in the printed
newsletter, we do not have any plans for ads in
the email version. Ron received a request to
evaluate some MIDI music software; since he is
not interested in using the software, he posted
the offer in a forum. A request was made to put
the offer in the newsletter.
Membership Director Les Anderson’s report:
From personal experience, Les indicated the
club has lost members because the member
misplaced the renewal notice. Les indicated
from March to September the club lost 17
members, shrinking the total number of
members from 109 to 92.

Old Business
SWOT Analysis — Tim Drenk indicated we are
waiting for the response window to close; the
response count is currently in the high thirties.
Wisconsin address for the club — See the
Treasurer’s Report above.
Getting Main Mac and iLife Special Interest
Groups (SIGs) set up — Kevin sent out an
email request for volunteers; he received a few
replies saying “Thanks but no thanks.” The
BOD asked that Kevin put something in the
newsletter. Bruce will ask Kevin to make some
face-to-face requests.
PayPal / Electronic Payment — Dave reported
there is a charge of about $1.15 per $15
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membership transaction. A motion to have
Dave set up a PayPal account was MSP.

attracting new members, we will need to create
an electronic form.

Renewal Notice Update — There was a
discussion of the straw horse notice provided
by Harry. Suggestions were made to eliminate
asking for the member’s occupation, to move
the ID Number up higher on the form, and to
add a statement asking for corrections to be
made on the form. A motion to adopt the
proposed form with those changes was MSP.
Harry agreed to work with Sandy Foderick to
update the renewal notice and to work with
Ron and Tim Tierney to update the newsletter
and on-line Membership form.

“Official” name as displayed (mini’app’les?)
on web site — As the meeting was breaking up,
Tim Tierney informally described some of the
difficulties he is having working with the lower
case starting letter, requested information about
the establishment of the name, and suggested
some reasons for changing the representation of
the club’s name. This matter needs to be
discussed formally at a later meeting.

Membership Coordinator Status — An article
in the October newsletter announced that Sandy
replaced Erik as the Membership Coordinator.

New Business
Saturday Workshop — Tom suggested a
workshop in early to mid November or in midDecember. The BOD’s preference was for Nov
14 with Nov 7 as back-up; otherwise, a January
date is indicated.
Nominating Committee — Bruce’s call for BOD
volunteers was met with silence. Bruce asked
Les to join him on the committee. Harry agreed
to provide a notice for the newsletter.
Purchase of another projector — Harry
provided an on-line survey in hard copy form.
A motion to have Bruce get rid of the older
projector was MSP. Tim Drenk agreed to
research projectors and provide some
recommendations. As a cost point, $700 +/- 200
was suggested. The projector being used now
cost $1382.
Call for Bylaws changes — Harry agreed to put
a notice in newsletter.
Membership renewals sent by email — The
BOD decided to wait for a final decision on
PayPal. If PayPal looks like a viable means of
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Next meeting: Scheduled for December 7, 2009,
at the Merriam Park Library at 7:00 pm. All club
members are welcome to attend.

A message from your SIG Director: Why are
SIGs (Special Interest Groups) important to
mini’app’les?
by Kevin Strysik (strysik@mac.com)
Simple. SIGs provide an essential resource to
members and guests. Are you having an issue
with or a question about FileMaker, sharing
your music library in iTunes, printing to your
new network printer, installing Windows in a
virtual environment, fighting with Keynote,
using a program that only runs in a pre-OSX
environment, upgrading software on your
MacBook, etc.? That’s where somebody in the
SIG community can help you. To further
expand and provide more services to
mini’app’les members, we need volunteers to
step up and create two new SIGs, one
specifically aimed at the iLife suite (iPhoto,
iMovie, GarageBand and more) and the other a
more general Main Mac SIG. As a leader of a
SIG you will typically hold a meeting once a
month at a local venue (such as a library or
community center) and prepare a general idea
of topics to be discussed. Our hope is that soon
we will find two fine people to get these SIGs
running, providing a great service for
mini’app’les members.
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iWork/AppleWorks SIG of October 2009
by Harry Lienke
This proved to be an exciting
meeting! When Bruce
Thompson set up the
projector and turned it on
(no computer attached yet),
a snowy, yellow-tinged logo
of the projector manufacturer appeared on the
projection screen. The Lienke PowerBook was
set up and attached to the projector; a snowy,
yellow-tinged, unreadable desk-top appeared
on the projection screen. We connected Bruce’s
MacBook Pro to the projector with the same
result. We experimented with the projector,
turning it off and on, and scrolling through its
various commands and menus. Nothing
corrected the problem. Since the presentation
was based on viewing and discussing videos,
this was a complete disaster.
Someone came up the the idea of networking
the laptops so small groups could gather
around several small screens and view the
videos. As hard as we tried, we were not able to
get the library wi-fi system to let us network.
Bruce then came up with the idea of setting up
our own private network. He set up a network
and the Thompson MacBook Pro and Dave
Lundin’s MacBook used that network to sign on
to the Lienke PowerBook with Screen Sharing.
Although the videos were not as easy to see as
they would have been on the projection screen,
we were able to see the videos and learn about
some more of the amazing features of iWork.
While the projector problem was
being explored, we discussed
locations for future iWork/
AppleWorks meetings. Last
month’s meeting in St. Paul was
attended by several residents of
the north and east sides of the metropolitan area
who seldom or never attend the meetings in
Edina and Bloomington. Everyone at this
month’s meeting indicated a willingness to
attend meetings at the Merriam Park Library in
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St. Paul, so I asked our Special Interest Group
(SIG) Leader, John Hunkins, if he was willing to
try scheduling iWork /AppleWorks meetings
alternating between Minneapolis and St. Paul
during the first half of 2010. John said he was
willing to do that, so we will be returning to the
saintly city in 2010. It was suggested if we no
longer need to use the Penn Lake Library, we
could go back to a start time of 7:00 pm;
everyone seemed to approve of this possibility.
It was also suggested if the attendance is better
in St. Paul, we move the iWork /AppleWorks
meetings there permanently.
Someone asked a question about whether a
novice needs to be concerned about cookies;
there is a concern about the amount of hard
drive space occupied by the cookies. The
consensus seemed to be that cookies take up
relatively little space and should not be a big
concern. It was pointed out that there are
concerns about privacy issues with respect to
cookies and “Flash Cookies” because they are
used by on-line services and vendors to track
your browsing habits and customize some of
the advertising presented to you. There was
mention of the commands available from
Safari’s menu to delete some or all of the
cookies and history accumulated during a web
browsing session; someone also mentioned the
privacy items available in Safari’s preferences.
Some folks have downloaded various plug-ins
and add-ons for Safari and Firefox to help
control storage of cookies on their machines.
Our jovial iWork/AppleWorks
SIG facilitator, Pam Lienke,
showed a tutorial video called
Format Data Values. The video
illustrated how to format data in
rows, columns, and individual cells
using the buttons in the center of the Format
Bar. Clicking the buttons produces common
data formats including Number, Per Cent, and
Currency but also has options for sliders,
steppers, and pop-up menus.
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The second tutorial video, Formula List View,
demonstrated how the Formula List button on
the Toolbar is used to review and change the
formulas in a spreadsheet.
Pam showed a third video called
Instant Alpha; the video used
Keynote to introduce Instant
Alpha, but this feature is available
in all three applications of iWork.
In the video, Instant Alpha
removed the single-color background from an
image. Pam launched Pages and showed how to
access Instant Alpha from the Format menu.
Using a photograph of one of her
grandchildren, she demonstrated how to use
Instant Alpha but also demonstrated how
difficult it can be to remove a multi-color
background.
The iWork/AppleWorks SIG will meet next at
the Southdale Library, 7001 York Ave. S, in
Edina. The meeting will commence on
November 4, 2009, at 6:30 pm and will conclude
by 8:45 pm. Next month Pam plans to look into
some additional aspects of the Inspector and
Sections in Pages and to explore the Magic
Move capability of Keynote.

Q&A SIG of September 2009
By Les Anderson

&A
Q

The September meeting was
held at the Merriam Park
Library. One topic centered on User Accounts.
A User Account is a method to have more than
one user on your Mac and permit each user to
have their own Desktop. You can create
individual user accounts for each person who
uses your computer. Each new user has a
separate home folder and can adjust his or her
own preferences without affecting other users.

working on a spreadsheet of financial data and
your daughter begs to check for iChat
messages, you can switch to your daughter’s
account. When she’s done checking for
messages, you can switch back to your account
and your spreadsheet is right where you left it.
You can get specific help on setting up users in
the Help section in the Finder menu bar. Simply
type “user” in the Search Box.
Another topic dealt with the Dock in OS X. It
can be used for more than just launching an
application. You can put a folder in the Dock
and keep often used files there. Folders,
however, must be near the far right edge of the
Dock. There is a thin vertical line in the Dock
near the right edge and non-applications like
folders and files must be placed there. It’s right
next to the spring-shaped icon. That is the only
place that will accept a folder or file. [Editors
Note: If you have positioned the Dock on the left or
right side of the screen, the area for the folders is
located at the bottom of the Dock and the line is
horizontal rather than vertical. The spring-shaped
icon (which accesses Apple's web site) will not be
visible if you have previously removed it.]

If you’ve moved or deleted a program, its icon
in the Dock will show a question mark “?”. Just
drag the question mark icon off the Dock and it
will go “poof” and be gone. If it is a program
you want, just find the application and put it
back on the Dock.
Other topics mentioned were: a problem
playing a DVD, installing another hard drive,
iTV, and iChat.
If you have a question or just want to sit in and
listen, come to the next Q&A meeting. Always
at the Merriam Park Library on the fourth
Monday of the month unless it conflicts with a
holiday.

You can turn on “fast user switching” to allow
more than one user to stay logged in to a
computer at a time. For example, if you’re
mini’app’les Newsletter — November 2009
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Member Opportunity: Review
MIDI-to-MP3 Software and
Receive a Free Copy
by Ron Heck
Here is an opportunity for a
member who works with MIDI music. A company
called ManiacTools is offering a free copy of their
program called MIDI to MP3 Converter for Mac,
provided we post a review of the software in the
newsletter.
If you are interested in testing this software, let me
know and I will contact the company to get the
program for you to test and review.
Below is the press release about the software.
–Ron (ronheck@comcast.net)

THE BEST WAY TO CONVERT MIDI TO MP3
ON MAC
September 29, 2009 - ManiacTools announces the
release of a new product for Mac OS X based
systems, MIDI to MP3 Converter.
While MIDI files are very popular, especially among
professional and amateur musicians, very often there
is a need to convert such files into WAV or MP3. For
example, creating an Audio CD from MIDIs is
impossible without converting MIDI to WAV/MP3
first. Furthermore, publishing MIDIs on the internet
is easy because of their small size, but there is a
downside: such files may sound cheap and unnatural
on other people’s computers. Unlike them, MP3s
always sound more or less the same and are
supported by various hardware.
Now users of Macintosh computers have an
opportunity to convert MIDIs to MP3/WAV with a
native Mac application. MIDI to MP3 Converter
offers a number of features that turn it into a unique
tool for everybody who collects or creates MIDI files.
By using SoundFonts it can surpass capabilities of a
particular sound card, producing tunes that sound
better, compared to the computer’s usual output.
Several SoundFonts can be used simultaneously, so
the user is able to assign individual SoundFonts to
each instrument instead of using ready-made
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General MIDI sets. Thus the program turns a usual
home computer into a powerful synthesizer with a
potentially unlimited number of instrument samples.
Using SoundFonts, MIDI to MP3 Converter works
very fast. For instance, it will convert a 5 minute
MIDI file into MP3 in a few seconds. In contrast,
tools that depend on the sound recording method will
need 5 minutes to convert the file.
The program has a built-in ID3 tag editor and can
supply converted files with important information,
like title, artist etc. It will accept MIDIs that are
dragged and dropped into its window. Multilingual
packages are included, MIDI to MP3 Converter will
display its text labels and messages according to the
system language.
MIDI to MP3 Converter for Mac requires Mac OS
X 10.5 or higher. It sells for $29.95; the free trial
version can convert up to 60 seconds of each file. The
program can be downloaded from http://
www.maniactools.com
ManiacTools was founded in 2002 and during its
career released several successful multimedia tools,
including mp3Tag, Visual MP3 Splitter & Joiner,
AudioConverter Studio, and others. As a prototype
for MIDI to MP3 Converter for Mac, a similar
application for Windows called MIDI Converter
Studio was used.
CONTACT INFORMATION:
Alex Pavlenko
ManiacTools
www.maniactools.com
press@maniactools.com
More about MIDI to MP3 Converter for Mac:
http://www.maniactools.com/soft/midi-tomp3-converter/?r=pr0909
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Apple Magic Mouse Review
from

www.gizmodo.com

The Magic Mouse is undoubtedly the best
mouse Apple’s made in years. They’ve taken
their knowledge in trackpad finger gestures and
one-piece manufacturing and made this
delicate, yet sturdy, bridge-shaped mouse. The
question is how it compares to other mice.

Compared to ergonomic mice, the Magic Mouse
is really low and aerodynamic, which means it
doesn’t contour to your hand and doesn’t give
the sensation that the mouse is a part of your
hand, like Logitech mice tend to. But it is
Bluetooth, so you don’t need an extra dongle,
and it’s powered by two AA batteries, which get
up to four months of use per charge, according
to Apple.
Physically moving the mouse and mousing is
fine and smooth, since there are two plastic bars
on the mouse’s underside that minimize contact
with whatever surface you’re on.

As we said in the hands-on, the mouse has one
piece of clear white plastic on the top, curved,
like a Dove bar. It has both right and left clicks,
like the Mighty Mouse, but differentiates itself
from other mice with its touch-sensitive
scrolling and two-fingered gestures. That’s the
big selling feature (other than the fact that it is a
beautiful looking mouse).
Even though there’s no clear delineation
between right and left buttons on the mouse
itself, the Magic Mouse knows to interpret a
click on the left or right half appropriately
(though right click needs to be activated from
inside System Preferences before you can use
it).

As a mouse
The Magic Mouse is a very, very pretty mouse—
something you wouldn’t feel like you had to
hide when not in use—and looks different
enough from other mice that people will ask
who made it, before awkwardly mumbling a
nevermind as they spot the grey Apple logo.
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As for tracking, it’s a pretty standard laser
technology that tracks decently on most
surfaces, including jeans and chairs. Still, the
Magic Mouse doesn’t have the crazy tracking
ability that Logitech’s MX mice just introduced
—so it can’t track on glass, and it can’t track on
glossy surfaces like the 13-inch MacBook.
The scrolling
The one thing Apple did completely right in the
Magic Mouse was the touch scrolling. It’s fluid,
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natural and works with any amount of fingers
on over 75% of the mouse surface (all the way
down to the Apple logo). Flicking up and down
gets you up and down web pages fast, as long
as you have “momentum” turned on in the
settings. Turn it off and you get fine-grained 1:1
scrolling—good if you want to slowly navigate
through a PDF doc.
You can also click with one finger and scroll
with another, letting you highlight blocks of text
like you would on a normal scrolling mouse.
On the whole, there’s no major piece of scrolling
functionality (other than a middle click) that
you lose transitioning from a standard scroll
wheel to this touch-sensitive solution. You just
get the ability to scroll in 360 degrees as a

bonus.
The only flaw is that you sometimes activate the
left (or right) click when you’re scrolling too
emphatically. I suspect this is just something
you’ll get used to over time, but it can be
annoying when you’re trying to scroll and you
navigate somewhere else instead.
Using two finger swiping to navigate web
pages, on the other hand, is a bit more
awkward. You’ll need to pinch the mouse on
the sides with your thumb and fourth/pinkie
finger while you’re scrolling, forcing you to
make a painful eagle claw all the time.

As good as the swiping gestures are, they’re
limited in what you can actually accomplish
with them. You can’t use more than three
fingers at a time, because you won’t have
enough fingers left to hold the mouse. There’s
also no option for touch-sensitive clicking, like
in trackpads, something that would have been
cool to have just as a bonus. You also can’t tell
which side is up just from touch until you click
down and feel nothing happen.
So far the Magic Mouse is only compatible with
the iMacs that they ship with, but will get broad
support soon.
It also can’t manage to stay free from scratches,
similar to white MacBooks that also get
scratched very easily. But the blemishes don’t
interfere with the mouse’s functionality—it’s
just painful to watch any new product lose its
pristine finish so quickly.
Is this the best mouse Apple has ever made?
Yeah, it is. The Magic Mouse is much better
than the Mighty Mouse, which people hated,
and might actually be good enough that nonMac users might want to pick it up as well,
supposing that they don’t really care about
ergonomics. Since it fills the gap between a tiny
travel mouse and a full sized desktop mouse,
the Magic is in a good position to grab users on
both ends.
It looks very nice
Touch scrolling works well
Swiping is less comfortable
Not very ergonomic
Send an email to Jason Chen, the author of this
post, at jchen@gizmodo.com.

What it can’t do
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This article is reprinted from Gizmodo.com under the Creative
Commons license.
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Even More Hidden Refinements in Snow
Leopard
by TidBITS Staff
As we’ve settled in with Snow Leopard, we’ve
found many tiny improvements. Undoubtedly,
even more will be discovered as time goes on,
but for now here’s another healthy serving of
unexpected – but much appreciated –
refinements.
iChat — Snow Leopard makes file sharing in
iChat easier and more dynamic, and expands
the program’s interface options.
• iChat displays a progress circle when you
send an image to another party. The circle
fills radially.

enhanced help resources for diagnosing
connection issues.
• Screen sharing in iChat can now be
encrypted if both parties sharing a screen
have MobileMe accounts and have enabled
encryption (iChat > Preferences >
Accounts > Security).
• On a multiple-monitor system where
you’re using screen sharing over iChat,
dragging the tiny inset preview of your
own screen to another monitor shifts the
remote screen to that monitor.
• The Connection Doctor (Video >
Connection Doctor) adds a Network Status
item to the Show pop-up menu that
explains what kind of router setup you
have; this feature is useful for
troubleshooting problems.
• Screen sharing now properly transfers all
keyboard commands to the remote server.
For example, the Command-Tab
application switcher switches applications
only on the remote system’s screen.

• Choosing View > Always Show Recipient
Bar puts a buddy’s status message and
color at the top of any iChat window. It
can also be used to select among multiple
open iChat logins you have to send a
message to that buddy, or to select among
multiple accounts you have registered in
Address Book for that buddy.

• Screen sharing also improves its
notification when a connection is lost.
Instead of a small dialog, the word
“Reconnecting” appears with a startupstyle spinner in large type across the
window.
Networking — Along with some tiny interface
enhancements, Snow Leopard improves
networking capabilities by extending Back to
My Mac support across user accounts.
It’s a small point, but the icons for servers on
the network (via Bonjour) that show miniature
versions of the specific model in question are
much prettier in Snow Leopard.

Screen Sharing — Screen Sharing in Snow
Leopard sees expanded security capabilities,
improved support for multiple monitors, and
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Back to My Mac supports multiple users on the
same computer. We had never encountered this,
but only a single account in Leopard could have
Back to My Mac enabled, regardless of whether
Fast User Switching was turned on or off. Apple
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notes in a support document that Snow
Leopard allows each user to have separate Back
to My Mac usage. (This limitation didn’t keep
MobileMe from working for multiple users on a
single computer.)

sync service and when it was last synced.
Other new items in that menu include
commands to Reset Sync Services entirely
and to open the iSync and Sync
Diagnostics utilities.

Option-Click Tricks — Option-clicking on
things in Mac OS X has, in the past, often
revealed additional menus or options. In Snow
Leopard, pressing Option reveals even more.
• Option-clicking the Volume icon in the
menu bar displays a list of sound input
and output devices. Choose one to switch
to it; it’s much easier than using the Sound
preference pane. Also, hold Shift and click
the icon to set the system volume, which is
separate from the general output volume.

• Option-click the Bluetooth icon in the
menu bar to view a few additional items in
the Bluetooth menu. Specifically, it enables
you to open three utility applications:
Bluetooth Explorer, Bluetooth Diagnostic
Utility, and PacketLogger. These are likely
of interest primarily to experts, but if
you’re having troubles with Bluetooth, the
Bluetooth Diagnostic Utility in particular
may be useful.

• Option-click the Battery icon in the menu
bar to show the battery’s current
condition – Normal is good. Other
messages might read Replace Soon,
Replace Now, Check Battery, or Service
Battery. Choosing the message opens a Mac
Help document with more information; an
Apple support note also provides more
detail, while this article at Pocket-lint has
great troubleshooting advice.

• Option-click the Sync icon in the menu bar
to display a menu showing each available
mini’app’les Newsletter — November 2009
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• Instead of pressing just the Space bar to
enter Quick Look, press Option-Space bar
to display the selected document in fullscreen Quick Look, expanding the preview
and hiding everything else that would
otherwise remain visible.

• In the Icon view in a Finder window, if any
filenames overlap, the names in the
background turn gray. It’s a nice tweak to
avoid the solid block of black that happens
when lots of items are stacked on top of
each other.

Odds and Ends — Snow Leopard seems to
have an endless number of tiny tweaks up its
sleeve, and here are a few final morsels.
• System Profiler (found in /Applications/
Utilities, or by choosing Apple menu >
About This Mac, and clicking More Info)
offers a new File menu item: Speak Serial
Number. Unfortunately, in our testing, the
default voice speaks the serial number
rather quickly, and changing the selected
voice in the Speech system preference pane
didn’t slow it down.
• In Expose, when your mouse pointer is
over a window thumbnail, press the Space
bar to expand it (press again to return it to
its minimized size).
• This will interest only programmers, but
Quick Look now applies syntax
highlighting for source code files in at least
some programming languages.
• If the Trash contains locked files, emptying
the Trash displays a new dialog that gives
you the option to delete all the unlocked
files, rather than telling you to repeat the
action with the Option key held down to
delete everything.

mini’app’les Newsletter — November 2009

Keep Us Posted — While the majority of tiny
refinements have most likely been found, as
users continue to plumb the depths of Snow
Leopard more are bound to be unearthed. If you
stumble across any particularly useful,
surprising, or interesting changes, let us know
about them – and we’ll do the same!
Unless otherwise noted, this article is copyright © 2009 TidBITS
Publishing, Inc. TidBITS is copyright © 2009 TidBITS Publishing
Inc. Reuse governed by Creative Commons License.
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Hot Links of the Month
Compiled by Ron Heck

Apple, Inc.
New ARM chips offer glimpse of
future Apple products | AppleInsider
http://tinyurl.com/lgoywh
Apple Dominates PCMag’s Service and
Reliability Survey | Gearlog
http://tinyurl.com/yhnnbb2
Apple takes double-digit home PC market
share - study | AppleInsider
http://tinyurl.com/ya9ffjb

Macintosh
Apple iMac Review: 27 Inches and Less Chin |
Gizmodo
http://tinyurl.com/yf39wp3
Apple Refreshes iMac Line | TidBITS
http://db.tidbits.com/article/10664
Apple’s New iMac, MacBook Grow Better,
Brighter | Wall Street Journal
http://tinyurl.com/yku9w9j
From Mac Portable to MacBook Pro: 20 years of
Apple laptops | Ars Technica
http://tinyurl.com/lymleg
Unplug Your Laptop to Keep Your Li-Ion Battery
Healthy | Gizmodo
http://tinyurl.com/nlg6k9

Mac OS X
A quick note on AppleWorks support in Snow
Leopard | cnet > MacFixIt
http://tinyurl.com/ykf9oc7
Make Old Apple Printers Work in Snow
Leopard | TidBITS
http://db.tidbits.com/article/10626
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Eight amazing Image Capture tricks |
MacWorld
http://tinyurl.com/yepawsz
Improve Snow Leopard’s Autocorrection
Capabilities | TidBITS
http://db.tidbits.com/article/10567
Make Leopard leap: Time-saving tips for OS X
10.5 | MacWorld
http://tinyurl.com/yk4w5py
Apple’s Snow Leopard bests Windows 7 in
speed tests | AppleInsider
http://tinyurl.com/yf3hnqj

iPod/iPhone/iTunes
The Complete Guide to Backing Up your iTunes
Library | iLounge
http://tinyurl.com/5on6un
Comparing Two Early iPhone GPS Navigation
Apps | TidBITS
http://db.tidbits.com/article/10600
See selection info in iTunes 9 | MacWorld
http://tinyurl.com/yz7g58y
A peek inside an iTunes LP file | Ars Technica
http://tinyurl.com/yc2n7tm
iPhone, Android, and Pre Beat BlackBerry and
Legacy Smartphones in CFI Group Customer
Satisfaction Study | Business Wire
http://tinyurl.com/y8nvxf2
How the iPhone works | Macworld
http://tinyurl.com/ygzvt5c

Miscellaneous
Ten New Details on the Apple Tablet | iLounge
http://tinyurl.com/ybnyemo
Apple Tablet To Redefine Newspapers,
Textbooks and Magazines | Gizmodo
http://tinyurl.com/yawfvep
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Members Helping Members
Need Help? Have a question the manual doesn’t answer? Members Helping Members is a group of
volunteers who have generously agreed to help. They are just a phone call or an email away. Please
call only during the appropriate times, and only if you are a current mini’app’les member and own
the software in question.
Apple II / IIGS Software & Hardware ............1, 2
AppleWorks / ClarisWorks...............................3, 4
Classic Macs ........................................................NV
Cross-Platform File Transfer .............................2, 3
FileMaker Pro .....................................................NV
iMacs ....................................................................NV
Intel-Based Macs .................................................NV
iPhoto .......................................................................3
iTunes / iMovie ..................................................NV
iWork ........................................................................4
Mac OS Classic ........................................................3
Mac OS X .............................................................NV
1.
2.
3.
4.
5.
6.
7.

Les Anderson
Tom Ostertag
Bruce Thompson
Pam Lienke
Ardie Predweshny
Charles Radloff
Ron Heck

651-735-3953
651-488-9979
763-546-1088
651-457-6026
612-978-9774
952-941-1667
651-774-9151

Microsoft Excel ................................................2, 5, 7
Microsoft Word ...................................................2, 7
MYOB .......................................................................5
Networks .............................................................NV
New Users ...............................................................1
PhotoShop ...........................................................NV
QuarkXPress ............................................................7
Quicken ....................................................................5
QuickBooks and QuickBooks Pro ........................5
VectorWorks.............................................................6

anderslc@usfamily.net
tostertag@usfamily.net
bthompson@Macconnect.com
plienke@aol.com

ronheck@comcast.net

DEW
EW
EW
DEW
DEW
D
DEW

D = Days, generally 9 am to 5 pm
E = Evenings, generally 5 pm to 9 pm
W= Weekends, generally 1 pm to 9 pm
NV = No Volunteer
Please call at reasonable hours and ask if it is a convenient time for helping you. By the way, many of
these volunteers can also be contacted on our forums. We appreciate your cooperation.
mini’app’les needs more volunteers for Members Helping Members — If you are willing to be a
Members Helping Members volunteer, please send an email message to Membership Director Les
Anderson or contact him on our forums with your name, telephone number, contact hours, and the
software and hardware areas you are willing to support.
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mini’app’les Membership Application and Renewal Form
Membership cost is $15.00 for one year. Please make your check payable to “mini’app’les”.
Name:
Company (if mailed to):
Address:
City, State, Zip:
Phone # (home):
Phone # (work):
Phone # (cell):
Membership ID # (if renewal):
Email:
Your email address will NOT be sold, shared, or distributed. It will be used only for official mini’app’les business such as distribution
of the newsletter and membership renewal reminders.

Check if this is a change of address notice
Check if you want to volunteer
Check if you want to be added to “Members Helping Members”
Check if you were referred by a club member (if so, please give member’s name)
Please mail this application and your payment to:
mini’app’les
P.O. Box 796
Hopkins, MN 55343-0796
Thank you for your support!
Benefits of mini’app’les Membership
• Access to the mini’app’les online forums. Post questions and/or answers about issues, trouble shooting,
products, buying and selling, special events, discounts, and news about Apple and the mini’app’les club.
• Access to our Members Helping Members network of professional and advanced users of Apple technologies.
These members volunteer their time to help other members with software, hardware, and other Apple related
issues.
• A variety of Mac Special Interest Groups (SIGs) that meet each month.
• Multi-SIG meetings and workshops to help members with computer problems. You can bring your equipment
to these events and receive support from knowledgeable Mac users to help diagnose your problem(s).
• Participation in drawings for computer hardware, software, and other computer related materials.
• Discounts from vendors and manufacturers. Refer to the on-line forums for current offers.
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mini’app’les

the minnesota apple computer users group, inc.

Introduction — This is the newsletter of mini’app’les, the
Minnesota Apple Computer Users’ Group Inc., a Minnesota
non-profit club. The whole newsletter is copyrighted © by
mini’app’les. Articles may be reproduced in other non-profit
User Groups’ publications except where specifically copyrighted
by the author (permission to reproduce these articles must be
given by the author). Please include the source when reprinting.
The mini’app’les Newsletter is an independent publication not
affiliated, sponsored, or sanctioned by Apple, Inc. or any other
computer manufacturer. The opinions, statements, positions, and
views are those of the author(s) or newsletter staff and are not
intended to represent the opinions, statements, positions, or
views of Apple, Inc., or any other computer manufacturer.
Instead of placing a trademark symbol at every occurrence of a
trade-marked name, we state we are using the names only in an
editorial manner, to the benefit of the trademark owner, with no
intention of infringement of the trademark.
Questions — Members with technical questions should refer
to the Members Helping Members section or bring their
questions to an appropriate SIG meeting. Please direct other
questions to an appropriate board member.
Dealers — mini’app’les does not endorse specific dealers. The
club promotes distribution of information that may help
members identify best buys and service. The club itself does not
participate in bulk purchases of media, software, hardware, and
publications. Members may organize such activities on behalf of
other members.
Submissions — We welcome contributions from our
members. Perhaps you’re using new software that you just can’t
live without. Maybe you have a new piece of hardware that you
find extremely useful and of high quality. On the other hand,
you might be struggling with problematic software or hardware.
Why not share your experience with other members by writing a
product review? Doing so may steer others towards quality
products or help them avoid the problems you may be having.
Submissions must be received by the 15th day of each month to
be included in the next month’s newsletter. Please send
contributions directly to our post office box (mini’app’les, PO
Box 796, Hopkins MN 55343), email them to
miniapples@mac.com, or email them to the newsletter editor at
ronheck@comcast.net

Board of Directors
President

Bruce Thompson
763-546-1088
bthompson@macconnect.com

Vice President

Tim Drenk
952-431-3978
tim@drenkconsulting.com

Secretary

Harry Lienke
651-457-6026
plienke@aol.com

Treasurer

Dave Lundin
715-483-3776
cdlundin@centurytel.net

Membership Director Les Anderson
651-735-3953
anderslc@usfamily.net
Publications Director Ron Heck
651-774-9151
ronheck@comcast.net
SIG Director

Kevin Strysik
65l-489-4691
strysik@mac.com

Director at Large

Tom Gates
612-789-1713
tgates@isd.net

Membership
Coordinator

Sandy Foderick
sfoderick@mac.com

The deadline for material for the next newsletter is the fifteenth
of the month. An article will be printed when space permits and,
if in the opinion of the Newsletter Editor or Publications
Director, it constitutes material suitable for publication.
This newsletter was produced using Apple’s Pages word
processor.
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